### Table of Contents

- Overview ......................................................................................................................... Page 3
- Banner Forms ................................................................................................................ Page 5
- FGIBDST: Organization Budget Status ........................................................................ Page 8
- FGIBSUM: Organization Budget Summary .................................................................. Page 12
- FGITBSR: Trial Balance Summary ............................................................................... Page 14
- FGITRND: Detail Transaction Activity .......................................................................... Page 17
- FRIGITD: Grant Inception to Date ................................................................................ Page 21
- FRIGTRD: Grant Transaction Detail ............................................................................... Page 24
- Appendix A: Configuring My Banner, My Links and Preferences .............................. Page 26
- Appendix B: More About Queries ................................................................................ Page 33
- Appendix C: Common Rule Codes ............................................................................... Page 35
- Appendix D: Other Useful Finance Forms .................................................................. Page 36
- Appendix E: Shortcuts .................................................................................................. Page 37
Overview:

Internet Native Banner (INB) is a fully featured client for real-time access to Banner. It has excellent response times but is somewhat cumbersome to learn for the casual user. Security constraints do not permit general campus users access to labor detail or tuition payment detail.

INB runs in two windows:

The one you work in.

- A user can have more than one INB instance open at a time.

The ‘behind the scenes’ control window in the internet browser.

Note: Closing this window will close both.
Banner Forms:

- All Banner forms have seven characters.
  - Example: **F G I B D S T**

- Naming Convention:
  - The *first* letter of the name identifies the primary system (product) in Banner which ‘owns’ the job, report, form or table.
    - Example: **F G I B D S T**
    - (F = Finance)

<table>
<thead>
<tr>
<th>Section</th>
<th>Letter</th>
</tr>
</thead>
<tbody>
<tr>
<td>Student</td>
<td>S</td>
</tr>
<tr>
<td>Finance</td>
<td>F</td>
</tr>
<tr>
<td>Human Resources</td>
<td>H</td>
</tr>
<tr>
<td>Financial Aid</td>
<td>R</td>
</tr>
<tr>
<td>General</td>
<td>G</td>
</tr>
<tr>
<td>Banner Exenter Solutions</td>
<td>B</td>
</tr>
</tbody>
</table>

  - The *second* letter of the name identifies the module in Banner that owns the job, report, form or table.
    - Example: **F G I B D S T**
    - (G = General Finance)
    - For the majority of your purposes, G will be the only module you will use.
Banner Forms (continued):

- The **third** letter of the name identifies the type of job, report, form or table.
  - Example: **F G I B D S T**
  - (I = Inquiry)

<table>
<thead>
<tr>
<th>Letter</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>A</td>
<td>Application</td>
</tr>
<tr>
<td>I</td>
<td>Inquiry Form</td>
</tr>
<tr>
<td>Q</td>
<td>Query Form (accessed from another form)</td>
</tr>
<tr>
<td>R</td>
<td>Report or Process</td>
</tr>
<tr>
<td>V</td>
<td>Validation Table View</td>
</tr>
</tbody>
</table>

- The last four letters of the name is the title of the job, report, form or table.
  - Example: **F G I B D S T**
  - (BDST = Budget Status)
Banner Forms (continued):

Banner forms can be accessed in two main ways:

1.) Inputting the form name in the Direct Access Field and pressing the Enter key.

2.) Double-click on a My Banner link. The My Banner links are user-defined. See Appendix A: How to configure My Banner for setup instructions.
Functional Use: The FGIBDST form provides the available balance for budget-funded ‘accounts.’ It also reports budget, revenue, expense and transfer amounts for a given fiscal year for both budget-funded and fund balance accounts. A user can drill to transaction-level detail.

Available Balance = Adjusted Budget – YTD Activity – Commitments
Steps to run an available balance inquiry:
1.) Enter the letter ‘O’ in the Chart field.
2.) Enter a two-digit Fiscal Year.
3.) Uncheck the “Include Revenue Accounts” checkbox.
4.) Enter query parameters: An Index or a Fund-Org combo.
5.) Select the Next Block button or press CTRL + Page Down to get the results.

Note: After running a query, use the Rollback button or press the Shift + F7 keys to return to the ‘key block’ and change the parameters.
FGIBDST available balance query sample output.

The available balance appears in the bottom right corner. This available balance is incorrect for all ‘fund balance’ accounts. Use the FGITBSR form to obtain the available balance for fund balance accounts.

Select the cell and then press the F3 key ('Fn'+F3 on Mac computers) to drill to expense transaction detail. Alternatively, you can select Options → Transaction Detail Information from the menu bar.
FGIBDST query sample output with revenue account codes included.

Revenues included in this example.

No available balance is calculated when the “Include Revenue Accounts” checkbox is selected.
Form FGIBSUM: Organization Budget Summary

**Functional Use:** Provides a summary of revenues, labor expense, direct expense & transfers for a Fund-Org combo.
FGIBSUM – Organization Budget Summary

Steps to run a FGIBSUM inquiry:
1.) Enter the letter ‘O’ in the Chart of Accounts field.
2.) Enter a two-digit Fiscal Year.
3.) Enter an Org and Fund code.
4.) Select the Next Block button or press CTRL + Page Down to get the results.

Note: After running a query, use the Rollback button or press the Shift + F7 keys to return to the ‘key block’ and change the parameters.
Form FGITBSR: Trial Balance Summary

**Functional Use:** Provides the available balance for Fund Balance (aka “Cash Funded”) accounts. Examples of fund balance accounts are professional development, research development & auxiliary accounts.

Available Balance = Current Fund Balance – Encumbrances
Steps to run a FGITBSR inquiry:
1.) Enter the letter ‘O’ in the COA field.
2.) Enter a two-digit Fiscal Year.
3.) Enter a Fund code.
   - For fund balance ‘accounts’, the Fund = Index (with some exceptions)
4.) Select the Next Block button or press CTRL + Page Down to get the results.

Note: After running a query, use the Rollback button or press the Shift + F7 keys to return to the ‘key block’ and change the parameters.
FGITBSR query sample output

Current Fund Balance is displayed at the bottom right. If Debit/Credit field at bottom reads: ‘Credit’ = surplus / ‘Debit’ = deficit.

If there are any encumbrances, you must subtract the ‘Current Balance’ in account code ‘3011 - Encumbrance Control Actual’ to get the Available Balance. For this example, the available balance is $142,473.75 ($143,333.75 – $860)
Form FGITRND: Detail Transaction Activity

**Functional Use:** Use the Detail Transaction Activity form to obtain transaction activity for a single fiscal year. The output can be exported to .csv file and opened in MS Excel.
FGITRND – Detail Transaction Activity

Note: After running a query, use the Rollback button or press the Shift + F7 keys to return to the ‘key block’ and change the parameters.

Once a query is started, it must be cancelled (or Ctrl + Q) before INB allows you to roll back and change the key block parameters.
This query will retrieve all posted revenue transactions greater than $10,000 for Fund: 1001 and Org: 10040 in FY14. (Revenue account codes begin with a four).

Results can be filtered by inputting a fiscal period. Ex. July = ‘01’, Aug = ‘02’,…, Accrual = ‘14’

Auto hints and error messages appear here.
FGITRND – Extracting data to a comma separated value (.csv) file.

Data extract steps:
With data returned, navigate to Help -> Extract Data No Key or Extract Data with Key. Including the Key will export the header block information also. If you do not receive the following dialog box, then you'll need to adjust your internet browser’s pop-up blocker settings.
**Form FRIGITD: Grant Inception to Date**

**Functional Use:** Use the Grant Inception to Date form to obtain the available balance for sponsored research projects (4xxxxx). A user can drill to inception-to-date transaction detail.

**Note:** The FRIGITD form works best for users with Master Fund and Master Org security access. Users without this access are encouraged to use the Budget Status by Account query from Self-Service Banner Finance (accessed through Trailhead) or the Budget Balance Checkbook Detail e~Print report.

**Available Balance = Adjusted Budget – Inception to Date Activity – Commitments**
**FRIGITD – Grant Inception to Date**

### Steps to run a FRIGITD available balance inquiry:

1. Enter the letter ‘O’ in the Chart of Accounts field.
2. Enter a Grant or Grant-Fund combo.
   - Users without Master Fund security access will not be able to leave the Fund field blank. Some grants are assigned multiple funds.
3. Select the Next Block button or press CTRL + Page Down.

### Note:
After running a query, use the Rollback button or press Shift + F7 keys to return to the ‘key block’ and change the parameters.
FRIGITD sample query output.

The available balance appears in the bottom right corner.

**NOTE:** This form is somewhat awkward in that the available balance updates as you scroll down. Ensure you’ve scrolled to the bottom to get an accurate available balance.

Select the cell and then press the F4 key ('Fn'+F4 on Mac computers) to drill to transaction detail.

The Fund Summary option can be helpful when grants have multiple funds.

Custom date range available.
Form: FRIGTRD – Grant Transaction Detail

**Functional Use:** Use this form to view and query a detailed list of inception-to-date transactions. The output can be exported to .csv file and opened in MS Excel.
FRIGTRD – Grant Transaction Detail

Steps to run a FRIGTRD transaction query:
1.) Enter the letter ‘O’ in the COA field.
2.) Enter a Grant or Grant-Fund combo.
3.) Change the Date From and/or Date To values to the desired range (Optional)
4.) Select the Next Block button or press CTRL + Page Down keys.
5.) Enter detail transaction query criteria.
6.) Execute the query by selecting the button or pressing the F8 key.

To exclude revenue.

Note: After running a query, use the Rollback button or press the Shift + F7 keys to return to the ‘key block’ and change the parameters.
Once a query is started, it must be cancelled (or Ctrl + Q) before INB allows you to roll back and change the key block parameters.
Appendix A: Configuring My Banner, My Links and Preferences:

**Configuring My Banner:**
The My Banner section allows a user to define a list of commonly used forms in a single location for ease of access. After logging into Internet Native Banner (INB), double-click the My Banner folder icon and then double-click “Empty: Select to build [GUAPMNU].”
With the My Banner Maintenance form open, enter the desired form names in the Object column on the right side. The descriptions will fill in automatically. After entering the first form, you can arrow down or use your mouse to select the next cell.

This section lists all the objects (which includes the Banner forms). You can run a query on the Object or Description columns to find the Banner form(s) you want.

Once your list is complete, you need to save your updates. File → Save or select the save button . Banner will display a message on the bottom left that reads: “FRM-40400: Transaction complete: [# of items ] records applied and saved”
A user can run a query to find Banner forms and then subsequently add them to the list.

Query Steps:
1.) Make the left-oriented Object or Description column active by selecting the data cells in either column.
2.) Start a query:
   
   Query → Enter, press ‘F7’ key or select the button.

3.) Enter the query criteria. ‘%’ is the Banner wildcard character. See Appendix B for a more detailed explanation on how to use it. This example will return all Banner forms with ‘Budget’ anywhere in the description. The queries are case-sensitive.
4.) Execute the query.
   Query → Execute, press the ‘F8’ key or click the button

Example results:
To add a form from the query results, double-click either the object column or description (the text will change to blue), and then select the Insert arrow. Alternatively, you can manually enter the form name in the right-oriented Object column in an open cell.

Any time the list is updated, save the updates. File → Save or select the save button.
**Adding Header Rows to Data Extracts:**

After logging into INB, go to File → Preferences to open the General User Preferences Maintenance form (GUAUPRF.)

Check the ‘Include Header Row in Data Extract’ checkbox.

Save your changes. File → Save or select the save button.
Creating Personal Links:
After logging into INB, go to File → Preferences to open the General User Preferences Maintenance form (GUAUPRF.) Select the My Links tab. The sections work in pairs, with one section for the description and another for URL.

Enter the description for the 1st personal link.
Enter the URL for the 1st personal link.

Save your changes. File → Save or select the save button.

The Hyperlink changes will take effect after exiting and logging back into INB.
Appendix B: More About Queries

- To query:
  - Press the F7 key or click on \( \) to begin a query.
  - Enter information you wish to query on (using optional wildcards)
  - Execute the query to retrieve data by selecting the F8 key or selecting the button

- Wildcards are special characters used in queries to represent one or more unspecified characters. Wildcards can also help with getting data based on a specified pattern match. For example, finding every document code that begins with “DAC.”
  - The percent character (%) represents any number of unspecified characters.
  - The underscore character (_) represents one occurrence of an unspecified character.

To get these results | Enter these criteria
--- | ---
All values that contain “a” | %a%
All values that begin with “An” | An%
All values that have “n” as the second character | _n%

**Example**: The FTVFUND – Fund Code Validation form contains information about funds such as the title and termination date. There can be multiple records for a single fund with different effective dates. If a title has been updated, there will be a record showing the old title and a newer record showing the revised title.
**Scenario:** You need the CCAC – Research Development index/fund number but don’t have it in your records. After navigating to the FTVFUND form, begin a query by pressing the F7 key or click on the button. To find all fund titles that contain “CCAC” anywhere in the text value, you would enter the following criteria and then execute the query by pressing F8 or selecting the button.

If the abbreviation is not used in the title and the center name is explicitly spelled out, this query will not return the desired information. Multiple searches may be necessary and thought should be given to different possible configurations. Also keep in mind that there are different effective date records and you may only be interested in the current title.
### Appendix C: Common Rule Codes

<table>
<thead>
<tr>
<th>Rule Code</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>BD__</td>
<td>Budget Entries</td>
</tr>
<tr>
<td>BR__</td>
<td>Budget Rollforward Entry</td>
</tr>
<tr>
<td>CA__, CB__</td>
<td>Student Charges</td>
</tr>
<tr>
<td>CAEC</td>
<td>Cancel Check C/M Addl w/Encumb</td>
</tr>
<tr>
<td>CAEI</td>
<td>Cancel check invoice addl w/encumb</td>
</tr>
<tr>
<td>CDEI</td>
<td>Cancel Check Invoice disc w/encumb</td>
</tr>
<tr>
<td>CNEC</td>
<td>Cancel Check - C/M w encumbrance</td>
</tr>
<tr>
<td>CNEI</td>
<td>Cancel Check - Invoice w encumbranc</td>
</tr>
<tr>
<td>CNNI</td>
<td>Cancel Check - Invoice w/o encumb</td>
</tr>
<tr>
<td>CO__</td>
<td>Change Order</td>
</tr>
<tr>
<td>CR05</td>
<td>Cash Receipt Entry</td>
</tr>
<tr>
<td>DIEI</td>
<td>Discount on Invoice w/ Encumb</td>
</tr>
<tr>
<td>DISC</td>
<td>Discount on Credit Memo</td>
</tr>
<tr>
<td>DISI</td>
<td>Discount on Invoice</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Rule Code</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>DNEC</td>
<td>Check - C/M w encumbrance</td>
</tr>
<tr>
<td>DNEI</td>
<td>Check - Invoice w encumbrance</td>
</tr>
<tr>
<td>DNNI</td>
<td>Check - Invoice w/o encumb</td>
</tr>
<tr>
<td>E0__, E100</td>
<td>Encumbrance Entry</td>
</tr>
<tr>
<td>F400</td>
<td>ES Feed - Chemicals</td>
</tr>
<tr>
<td>F500</td>
<td>PCard Feed - EXTERNAL</td>
</tr>
<tr>
<td>F600</td>
<td>TelComFeed - CHARGES</td>
</tr>
<tr>
<td>FZ__</td>
<td>Journal Entry</td>
</tr>
<tr>
<td>GRIC</td>
<td>Indir Cost Charge</td>
</tr>
<tr>
<td>H___</td>
<td>Payroll Entries</td>
</tr>
<tr>
<td>IN___</td>
<td>Invoice</td>
</tr>
<tr>
<td>PORD</td>
<td>Purch Ordr - Establish</td>
</tr>
<tr>
<td>REQP</td>
<td>Requisition - Reservation</td>
</tr>
</tbody>
</table>
Appendix D: Other Useful Finance Forms

- FPIPURR – Purchase Order Inquiry
- FAIVNHD – Vendor History
- FOIDOCH – Document cross reference
- FPIOPOF – Open PO’s by FOAP
- FPIOPOV – Open PO’s by Vendor
- FGIOENC – Open Encumbrances by FOAP
- GUAUPRF – Set user screen preferences
- FGIENCD – Encumbrance Detail Activity
- FAIINVE – Invoice/Credit Memo Query
- Fund-Org-Account Code-Program (FOAP) Queries
  - FTVFUND
  - FTVORGN
  - FTVACCT
  - FTVPREG
# Appendix E: Shortcuts

<table>
<thead>
<tr>
<th>KEY</th>
<th>Esc</th>
<th>Tab</th>
<th>F1</th>
<th>F2</th>
<th>F3</th>
<th>F4</th>
<th>F5</th>
<th>F6</th>
<th>F7</th>
<th>F8</th>
<th>F9</th>
<th>F10</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>Cancel</td>
<td>Next Field</td>
<td>Help</td>
<td>Drill Field/Item</td>
<td>Drill Record</td>
<td>Insert New Record</td>
<td>Enter Query</td>
<td>Execute Query</td>
<td>Search (LOV)</td>
<td>Save</td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>Shift</td>
<td>Previous Field</td>
<td>Display Error</td>
<td>Count Query Hits</td>
<td>Exit with Value</td>
<td>Clear Record</td>
<td>Clear Block</td>
<td>Remove Record</td>
<td>Clear Form &amp; Rollback</td>
<td>Print</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Ctrl</td>
<td></td>
<td>Next Field</td>
<td>Show Keys</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>KEY</th>
<th>Page up</th>
<th>Page Down</th>
<th>Up Arrow</th>
<th>Down Arrow</th>
<th>Left Arrow</th>
<th>Right Arrow</th>
<th>Q</th>
<th>Space Bar in Check Box Fid</th>
<th>Left Mouse Double Click</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td></td>
<td></td>
<td>Previous Record</td>
<td>Next Record</td>
<td>Prev. Radio Button</td>
<td>Next Radio Button</td>
<td>Toggle On/Off</td>
<td>On amount field=calculator</td>
<td></td>
</tr>
<tr>
<td>Shift</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td>Dynamic Help</td>
<td></td>
</tr>
<tr>
<td>Ctrl</td>
<td>Previous Block</td>
<td>Next Block</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td>Exit or Cancel</td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

37